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The purpose of these guidelines is to specify directions for graduate students who are submitting a thesis or a dissertation (hereafter the reference will be simply to "thesis") in partial fulfillment of degree requirements.  The guidelines herein take precedence over those in the style manuals required by departments as well as earlier versions of the "Directions."  Students should consult their thesis directors to determine if the department requires the use of a specific style manual for formatting or if the University’s template can be used for formatting.  Students should avoid using another thesis as a model.  Because of the updating of style manuals and SHSU thesis guidelines, what was accepted in the past may now be unacceptable.  The thesis will be evaluated according to the current declared style manual and the current SHSU thesis guidelines or the University’s current template
HUMAN RESEARCH PARTICIPANTS
Research involving human participants must be approved by the SHSU Committee for the Protection of Human Subjects prior to the commencement of the project.  Instructions and applications are available from the Office of Research and Sponsored Programs, Roy Adams House or from the OSRP web site at http://www.shsu.edu/dept/office-of-research-and-sponsored-programs/ .
ANIMAL SUBJECTS

Research involving animal subjects must be approved by the SHSU Institutional Animal Care and Use Committee prior to the commencement of the project.  Instructions and applications are available from the Office of Research and Sponsored Programs, Roy Adams House or from the OSRP web site http://www.shsu.edu/dept/office-of-research-and-sponsored-programs/ .
PLAGIARISM

According to the Sam Houston State University Student Guidelines, "The University expects all students to engage in all academic pursuits in a manner that is above reproach.  Students are expected to maintain complete honesty and integrity in the academic experiences both in and out of the classroom."  A graduate student should be careful in the use of copyrighted material and in documenting the use of another person's ideas or words.  The SHSU Student Guidelines defines plagiarism as "the appropriation of another's work or idea and the unacknowledged incorporation of that work or idea into one's own work offered for credit."  Disciplinary proceedings may be initiated against a student accused of plagiarism under the University's guidelines for academic honesty.  The MLA Handbook provides a lengthy discussion of plagiarism, including examples, to help writers understand what constitutes plagiarism and how it can be avoided.  A guide to understanding and avoiding plagiarism is available on the Library’s website (http://shsulibraryguides.org/plagiarism ).  
Turnitin
Designed to prevent plagiarism and help students learn how to avoid plagiarizing material, Turnitin is a component of the Graduate Studies Blackboard Organization, to which every graduate student who is writing a thesis or dissertation has access. Before submitting the thesis, it is in the best interest of the student to submit his or her thesis or dissertation to Turnitin using the Graduate Studies Blackboard Organization.   
SPECIAL REQUIREMENTS AND PROCEDURES
Quality of Paper

Two original copies must be submitted to the library on acid-free, 25% rag or cotton fiber content white paper of at least 20 pound weight.  This paper must have a watermark certifying cotton bond.  Erasable bond is NOT acceptable.

A thesis must be printed on one side of the paper using a laser printer (inkjet often smears) and toner of excellent quality.  There is evidence that the ink from laser printers will not permanently adhere to the surface of cotton bond paper.  Therefore, the copies submitted for binding should be photocopied onto the cotton bond, acid-free paper. 

Typeface, Headings, and Spacing
A 12 point font is required of all text and double spacing is required.  Headings, labels and titles may be in bold and in a font size up to 14 point.  The same font size and type should be used for headings, etc., consistently throughout the text.  Classical fonts such as Times New Roman, Helvetica, Courier, Geneva, and CG Times are acceptable.  Ornate fonts, i.e. script, are not acceptable.  Students who wish to use another typeface must obtain approval from the Library Director’s Office before typing their thesis or dissertation.  Below are selected examples of fonts acceptable for thesis text.  Font sizes for tables and figures may vary but must still be legible in final form.


Font
Example



Times New Roman
This is Times New Roman 12 pt.


Helvetica
This is Helvetica 12 pt.


Geneva
This is Geneva 12 pt.


CG Times
This is CG Times 12 pt.


Preparation

Keyboarding must be error free and the master copy should be of high quality and contrast.  Documents produced with inkjet printers are not acceptable.  Copies of the thesis must be made using a high quality laser printer or photocopier.  Additional copies of the thesis for personal or departmental use must be of excellent quality, but need not be on cotton bond, acid free paper. 

Students MUST take a draft version to the Newton Gresham Library for preliminary approval of the format.  This may be done at any time, but not later than 6 weeks prior to graduation.  The draft version should be emailed to NGLThesis@shsu.edu. This draft should include all tables, charts, bibliographies, typefaces, etc.  A student may be asked at any time to make changes or corrections: getting preliminary approval of a draft will greatly aid the student in successfully completing this process.  After receiving approval to print copies of the thesis, the student must take the final copies of their thesis to the Office of the Director of Library Services. (see Submission and Binding)

Graduate students writing a thesis or dissertation will begin the route sheet process once they have completed the public defense and the final edits of their work have been accepted by their committee. The Route Sheet should be sent to the office of the Director of Library Services, after the public defense of the thesis, for signature to indicate formal approval on matters of form, preparation, and submission.  The electronic Route Sheet is located on the Graduate Studies website. The route sheet is forwarded to the Office of Graduate Studies for signature before submission to the Registrar’s Office.
Abstract
An abstract is required for all theses and dissertations.  The abstract is a descriptive summary, no longer than 350 words, composed of three principal parts:  statement of the purpose, the methods, and the findings of the thesis research.
Tables and Figures
Tables and figures must appear in the text as near as possible to the discussion relating to them.  Under no circumstances will a table or figure precede the first discussion of its content.  This rule includes tables or figures incorporated into the text.

Tables must be numbered consecutively using Arabic numbers throughout the thesis, as should figures, examples, and illustrations.  Each table or figure in a thesis must have a caption that tells concisely what it contains.  The caption must be placed above a table, but below a figure.  Figures must be centered on the page.  In cases of oversize tables and figures, the student must consult with the Newton Gresham Library. A list of tables and a list of figures should be placed after the Table of Contents if there are 5 or more tables and/or figures in your thesis
Computer-generated tables and figures are acceptable, provided they are clear and legible and meet margin requirements.  Bar graphs must use shading or hash marks: do not use colors to differentiate among data divisions.  Colors do not reproduce well in black and white or when microfilmed.  Line graphs should have clear distinct lines with symbols that are easily differentiated.
If a figure is of such nature that the scanning or photocopying process will not produce a good copy, photographic reproduction may be advisable.  Prior approval by the Newton Gresham Library is required in these cases.

Bibliography/List of References

A list of works (i.e., journal articles, books, electronic sources, etc.) used in preparation of the thesis must be included.  Students should consult the style manual required by their department regarding criteria for inclusion in the bibliography/list of references.  It should be understood that the most recent edition of the selected style manual should be followed (see the Appendix for a list of appropriate style manuals).

In some cases, style manuals do not contain up-to-date instructions on documentation of electronic publications (i.e., E-mail, software, electronic journals, etc.), government documents, or legal documents.  When the department’s style manual fails to provide sufficient instructions regarding bibliographic documentation, it is suggested that the student consult the Publication Manual of the American Psychological Association (APA) or a style manual associated with their discipline.  Specialized style manuals for citing legal material and electronic information are available in the Newton Gresham Library.
The bibliography/list of references should be double spaced throughout.  Do not insert additional blank lines between entries in the list.  Format should follow the style manual or journal style selected by the student under the guidance of their thesis advisor.

Copyright

Since a thesis is legally classified as a publication, care must be taken not to violate copyright laws.  If the thesis contains any material (e.g. figures, tables, test instruments, text, or photographs) taken from copyrighted sources, the student must determine if a letter of permission from the copyright holder is needed.  This is true even if the student or thesis adviser is an author of the material; in such cases, a letter from the publisher may still be needed.  Students must inform the copyright holder that the dissertation will be sent to UMI Dissertation Services and sold on demand (see Microform Copies).  If a letter is needed, it must be included in a separate appendix; proper credit should be given in the text.  A copy of the letter must be placed in the thesis/dissertation.  See the Library’s webpage for Thesis & Dissertation Guidelines & Tools, http://library.shsu.edu/research/guides/thesis/index.html . Kenneth D. Crews has prepared a booklet for dissertation authors, Copyright and Your Dissertation or Thesis: Ownership, Fair Use, and Your Rights and Responsibilities. 
Copyright Registration

The University does not register copyright.  Doctoral students may register copyright when they submit their dissertations to Proquest Dissertation Services (see Microform Copies).  Proquest acts as an agent for copyright registration and the copyright registration form is available in the Library.  The fee for this service is $65, which includes the registration fee and the two microfilm copies required by the Library of Congress.  Candidates for the master’s degree must also decide if they want to register their copyright.  Under current U.S. Copyright Laws, any original document containing your name and a date is protected without paying for copyright registration.  Copies of the registration form can be downloaded from the U. S. Government’s official site http://lcweb.loc.gov/copyright.  Students may choose to insert a copyright page in your thesis in the proper place even if you are not registering your copyright.  If a thesis is to be copyrighted, the copyright page must be inserted immediately after the title page and assigned page number ii.  The following information must appear centered on the copyright page:

Copyright  ©  <year> by <name>
All rights reserved

Margins and Page Numbers
Top, right, and bottom margins MUST be one inch.  The left (or binder's) margin MUST be one and one-half inches because one-half inch is required for binding, as is the case with this document.  The left margin MUST be justified; however, it is not necessary to justify the right margin.

Page numbers should be placed in a header 0.5 inches from the top of the page, outside the top margin.  The page number should be one inch from the right edge of the sheet flush with the right margin and one-half inch from the top of the page.  Preliminary pages (abstracts, preface, table of contents, etc.) are numbered in lower case Roman numerals centered on the bottom of the page in a footer 0.5 inches from the bottom of the page, outside the bottom margin.  The lower case Roman numerals are suppressed on the title and approval pages.  A page number (an Arabic numeral) is assigned to all pages of the body of the thesis.

Sometimes a page cannot be made to appear exactly on the one inch line.  Slight variations, when absolutely necessary, are permissible.  In any event, avoid carrying over the last line of a paragraph to a new page. Note: For instructions on how to include proper pagination for a landscape page, please see p. 37.

FORMATTING
A template designed to manage formatting issues such as correct placement of page numbers; headings; placement of tables and figures; and the formatting of the Title Page, Approval Page, and the Table of Contents; etc. can be found on the Graduate Studies’ website and the Library’s website. Follow the instructions for downloading both the template and the User Guides.  This template may be used for formatting; check with your thesis director to determine if your department uses the template or if you should use a specific declared style manual.
SUBMISSION AND BINDING
The deadline for submission of theses and dissertations to the appropriate academic dean's office is published in the Academic Calendar.  The Academic Calendar can be found on the University’s webpage under Fast Links.
The Electronic Route Sheet and one extra copy of the Abstract printed on acid-free paper must accompany the thesis when submitted but are not bound with it.  Once the library’s requirements are met, the Electronic Route Sheet will be approved by the Director of Library Services (“Newton Gresham Library Director” on the Electronic Route Sheet) and submitted to the Office of Graduate Studies. The Office of Graduate Studies is responsible for the submission of the Electronic Route Sheet to the Registrar's Office.  Signatures are no longer required on the Approval page.
All copies to be bound will be submitted to the office of the Library Director as follows:
For Thesis:  

TWO (2) original copies (on acid-free, 20/25-pound-weight paper with 25% watermark) for the library, ONE (1) copy for the thesis director, ONE (1) copy for the department (a requirement that applies to Criminal Justice students and that may apply to others, check with your department chair).  Students may submit one or more copies for binding as personal copies if desired. 
For Dissertations:

ONE (1) copy on acid-free, 20/25-pound-weight paper with 25% watermark) for the library for binding.  Doctoral students must also provide TWO (2) copies of high quality and contrast to be submitted to UMI Dissertation Services and for microfilming
(these will not be bound).  

Additional copies required by:

Criminal Justice requires a copy for the College; the Psychology program requires a bound copy for the chair of the dissertation.
The copy for the UMI Digital Dissertations Services will be digitized for its database, microfilmed, and copied for publication. Instructions and forms are available in the office of the Director of Library Services. The “Agreement Form” must be completed at the time of submission to the Library. The student does not have to complete the “Copyright Registration Form” if he/she does not want to officially register copyright. The University will pay UMI’s publication fee ($65); however, the student must pay the $65 copyright registration fee, if desired, at the time the dissertation is submitted. Note: These costs are subject to change.
The cost of binding a thesis is approximately $15 per copy (as of 2015, there is also a $15 charge for microfilming (as of June, 2013). (Note: These costs are subject to change.) Binding and shipping fees are due upon submission of the thesis to the Library Director's office. 

The office of the Library Director is in the Newton Gresham Library, Room 207. Office hours are Monday to Friday, from 8:00 AM to 5:00 PM.

Microform Copies

The library microfilms all theses and dissertations for the university’s archives.  Doctoral dissertations are microfilmed and digitized by UMI, a process that constitutes publication and makes the dissertation available to the public.  Agreement forms for this microfilming and instructions from UMI are available in the office of the Director of Library Services.  All forms must be filled out when the dissertation is submitted.  Extra copies of the Title Page and Abstract will be forwarded to UMI for inclusion in Dissertation Abstracts International.  Currently, the Office of Graduate Studies pays the $65 publication fee to UMI Dissertation Publishing on behalf of our students.
JOURNAL MODEL
Departments may elect to use the format of a journal article for chapters of the thesis.  The journal format to be followed will be noted in the research proposal and the thesis: see page 22 for format and wording of the journal model sentence.  The journal should be a respected scholarly journal well known in the major field.  A copy of the journal’s instructions to the author and copies of three articles published within the last three years must be submitted with a draft of the thesis to the Library.  A master’s thesis should include at least two such articles; a dissertation may include two or more such articles.

The thesis should be presented as a single unit; continuity from chapter to chapter is important.  Several studies or experiments may be presented in separate chapters or major sections.  Each chapter may have subdivisions, such as introduction, methods, discussion, and summary.  Continuity in the thesis is provided by a common abstract, introduction, detailed review of the literature, and conclusion that ties together the major results and reference sections.  Unavoidably, this will duplicate some of the introductory and concluding material in each article.  The thesis will have a common abstract and reference section.  The reference section will be an integrated list, not a series of lists.  Appendices may be added to present information not included in the body of the thesis.

Whenever there are differences in format and layout between the specifications of the Directions for Thesis and the journal model, this guide overrules the journal.  The journal will be followed for:

· location of table titles (above or below)

· location of figure titles (above or below)

· reference section (entry format)

Consistency of style and form should be the rule throughout the manuscript.  Continuous pagination is required throughout the thesis.  If tables and figures are placed in a separate section, they should include a chapter designation as well as a table/figure number (Table 1.1, 1.2, 1.3; 2.1, 2.2, 2.3) both in the text and in the caption.  The usual requirements for margins, consistency in chapter or section titles, and other mechanics as specified elsewhere in this guide will apply.
The thesis is not expected to duplicate the typographic style of the published journal; the publication and layout practices (use of double columns, extra spacing, etc.) are not to be followed.  A journal’s “Instruction to Contributors” is not followed exactly when writing a thesis.  These instructions are for the convenience of editors and do not necessarily apply to the format of a thesis.  Individual manuscripts serving as chapters of the thesis need not have the same internal structure.  Instead, each is presented in the style appropriate to the selected journal.

Journal Model Sentence:
· At the bottom of the cover page for the article/chapter

· Beneath a solid line 10 to 15 spaces long

· In a complete sentence with a period at the end

· Suggested wording:  This thesis (or dissertation) follows the style and format of <journal name>.

· Type for journal (Italics, underline or regular) is the same used for journal titles in reference section; journal name should be spelled out completely

· Single spaced if more than one line
CREATIVE THESES

All theses, including those in creative writing and music, are expected to conform to the basic university guidelines for margins, paper, and copy quality.  The thesis should contain an abstract, an introduction, and a review of the literature or critical essay that unifies the presentation and sets the tone for the creative work.  The introduction should provide the rationale for the acceptance of a Creative Thesis.  The following elements are required for acceptance of a Creative Thesis:

· Title Page

· Approval Page

· Dedication (optional)

· Abstract

· Acknowledgments (optional)

· Table of Contents

· Introduction

· List of References

· Creative Section

· Vita

PUBLICATION OF RESEARCH
Graduate students may publish material that subsequently will be used as part of the thesis provided that the chair of the student’s thesis or dissertation committee is notified in writing at the time the student submits the paper for publication.  The notification should include the article title, the journal name, the names of all authors, and the date of submission.  The student must be the first author of each article used.  The names of all authors, in journal-submitted order, and the name of the journal (with volume, page numbers, and date, if known) must be given as a footnote to the title on the first page of each manuscript so as to indicate the current status of each manuscript.  Evidence of permission to use articles that have been published or accepted for publication prior to completion of the thesis or dissertation must be included in the appendices.  

Students should be aware that the agreement signed when a journal accepts an article for publication usually assigns all rights to the journal and the student may no longer possess rights to the material.
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APPENDIX 
SPECIMEN PAGES 

For Non-Template Thesis/Dissertations

On the following pages are examples of the proper form for the TITLE PAGE, APPROVAL PAGE, ABSTRACT, TABLE OF CONTENTS, LIST OF TABLES, LIST OF FIGURES, CHAPTER HEADER, and VITA.  Samples for proper formatting for TABLES and FIGURES are also included for illustrative purposes.

An abstract is required for all theses.  The abstract is a descriptive summary, no longer than 350 words, composed of three principal parts:  statement of the purpose, the methods, and the findings of the thesis research.
A vita is also required as a part of each thesis.  Usually, the vita as a narrative does not exceed one page.  It contains personal, academic, and professional information about the author.  Some departments may prefer a vita that provides more specific, detailed information.  Consult with your thesis director about which of the two forms should be used.
THE TITLE OF THE THESIS GOES HERE CENTERED, IN ALL CAPS, AND

DOUBLE SPACED
__________

A Thesis

Presented to

The Faculty of the Department of <Department Name>
Sam Houston State University

__________

In Partial Fulfillment

of the Requirements for the Degree of

Master of Arts

__________

by

Isaac M. Student
May, 2015
(Note:  Spacing will vary slightly according to length of the title)
THE TITLE OF THE THESIS GOES HERE CENTERED, IN ALL CAPS, AND

DOUBLE SPACED
by

Isaac M. Student
_______________________________________

APPROVED:


U. R. Professor

Thesis Director


<Thesis committee member>

<Thesis committee member>


                                                                         <Complete name of Dean>, Dean

                                                                           College of <College Name>
(Note:  Spacing will vary according to the length of the title.  Master must be on acid free paper, 20-pound-weight paper for signatures.   Signatures are no longer required)

ABSTRACT

Student, Isaac M.,  The title of the thesis goes here.  Master of Arts (<Department>), May, 2015, Sam Houston State University, Huntsville, Texas.


This is the format for the bibliographic information required for the abstract.  The content of the abstract that follows this citation will vary according to the subject area.  The abstract should be concise and informative; however, the abstract must be less than 350 words in length.  In general, it should state the purpose and describe the subjects and the methodology used in the study.  The abstract should also describe the findings, conclusions, and implications of the study.  Students should consult their thesis director and style manual to determine the content of the abstract.  The abstract must be signed by the thesis director below.

A list of key words must be included at the bottom of the abstract; however, key words and the title information do not count toward the 350 word total.  Key words should be specific terms or phrases used in the thesis that would enable a person to successfully search out the content of the document if it were in a library database.  If one of the key words is a proper noun, follow the normal rules of capitalization.  Likewise, italicize or underline foreign words or appropriate scientific nomenclature.  The first word of each key term should be capitalized.

KEY WORDS:  Thesis guidelines, Index word, Sam Houston State University, Graduate School, Texas.
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CHAPTER II
THE TITLE OF THE MANUSCRIPT BELONGS HERE, CENTERED, ALL CAPS,

AND DOUBLE-SPACED1
(Use whichever style is appropriate below based on the status of the manuscript.  The manuscript must meet the basic style and format conventions of the target journal listed. The footnote goes at the bottom of the page).
1Student, I. M., and U. R. Professor.  2001.  The Journal of Whatever. 82:201-223. Reprinted with permission of publisher.

1Student, I. M., and U. R. Professor.  2001.  Accepted by The Journal of Whatever. Reprinted with permission of publisher.

1Student, I. M., and U. R. Professor.  2001.  Submitted to The Journal of Whatever.

1Student, I. M., and U. R. Professor.  To be submitted to The Journal of Whatever.

VITA

Isaac M. Student

EDUCATION

Master of Arts student in < Discipline > at Sam Houston State University, August 2002 – present.  Thesis title: “Thesis title goes here in normal text.”

Bachelor of Arts (May 2002) in <Discipline>, Anytown State University, Anytown, Texas.
ACADEMIC EMPLOYMENT

Graduate Teaching Assistant, Department of <Program>, Sam Houston State University, August 2011 - present.  Responsibilities include: assisting professors with the preparation and presentation of undergraduate courses, grading, and tutoring.
Research Assistant to U. R. Professor, Department of <Program>, Sam Houston State University, Spring 2003 - present.  Research activities include …..

PUBLICATIONS

Student, I. M., and U. R. Professor.  2014.  The title of the manuscript goes here. Name of the Journal 12:345-250.

Student, I. M.  (In review).  Title of a second manuscript. Name of the Journal.

PRESENTATIONS AT PROFESSIONAL MEETINGS

Student, I. M., and U. R. Professor.  The title of the presentation goes here.  27th Annual Meetings of the Society of ….., Anytown State University, Anytown, Texas, 24 June 2014.

ACADEMIC AWARDS

Outstanding Graduate Student, Department of Department of <Program>, Sam Houston State University, April 2013.
PROFESSIONAL MEMBERSHIP

American Society of …..

Texas Association of …..
TABLES, FIGURES, AND ILLUSTRATIONS
Tables, figures, and illustrations must appear as near as possible to the discussion relating to them.  Under no circumstances may a table, figure, or illustration precede the first discussion of its contents; this rule includes any tables, figures, or illustrations that are incorporated into the text.

Tables must be numbered consecutively throughout the thesis using Arabic numbers (i.e., Table 1, Table 2, etc.).  Figures and other illustrations should also be numbered consecutively with Arabic numbers, but they are numbered independently from tables (i.e., Figure 1, Figure 2, etc.) regardless of whether tables are used or not.

Each table, figure, or illustration in a thesis must have a self-explanatory caption that tells concisely what it contains.  The caption must be placed above a table, but below an illustration or figure.  Illustrations must be centered on the page.  In case of oversize tables, figures, and illustrations, the student must consult with the Newton Gresham Library.

Table 2.  Analysis of variance, means, and standard deviations for the Global Distress Scale for male and female groups.  (Note: The format for this title and the table itself will follow the guidelines for your disciple or journal model.)
	Male Groups

	Source
	df
	Sum of

Squares 
	Mean

Squares
	F
	p

	Between Groups
	2
	430.65
	215.33
	2.05
	0.14

	Within Groups
	61
	6422.81
	105.29
	
	

	Total
	63
	6853.46
	
	
	


	Female Groups

	Source
	df
	Sum of 

Squares
	Mean

Squares
	F
	p

	Between Groups
	2
	109.71
	54.85
	0.71
	0.49

	Within Groups
	61
	4687.00
	76.84
	
	

	Total
	63
	4796.71
	
	
	


	Means and Standard Deviations

	
	
	Police-Police
	Police-Civilian
	Civilian-Civilian

	
	M
	48.77
	45.54
	47.55

	Female
	SD
	10.21
	6.42
	8.62

	
	n
	25
	18
	21

	
	
	
	
	

	
	M
	53.00
	48.02
	47.44

	Male
	SD
	13.64
	7.20
	7.34

	
	n
	25
	18
	21
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Table 5 (below) has been incorporated into the text rather than displaying it on a separate page.  As demonstrated here, text may precede or follow a table on any page, but the table must not precede its reference in the text.  The caption for Table 5 has been placed above the table and numbered with an Arabic number.  The text on this page would continue as appropriate to allow the table to fit above the bottom margin.  A blank line should be placed above or below the table to adequately separate it from the text.
Table 5.  Multivariate test of parental bonding scales by the Self-Dimension.

	MANOVA F (4, 224) = 5.59, p < 0.000

	
	Self-Dimension
	
	

	Scales
	Positive

n=122

M/(SD)
	Negative

n=113

M/(SD)
	Univariate

F
	p

	Father Caring
	25.23

(9.67)
	20.56

(9.54)
	13.18
	0.000

	Father Overprotection
	11.53

(7.95)
	12.96

(7.46)
	1.00
	0.320

	Mother Caring
	30.24

(7.54)
	26.24

(8.45)
	11.64
	0.001

	Mother Overprotection
	11.32

(6.98)
	15.06

(8.05)
	 6.46
	0.012
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Figure 1.  Mean MMPI Validity and selected Clinical Scales scores for male alcoholics (n=637) and female alcoholics (n=339).
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STYLE MANUALS

The following style manuals have been accepted by the Sam Houston State University Graduate Council.  The most recent edition of these manuals should always be followed.  CONSULT YOUR THESIS DIRECTOR TO DETERMINE WHICH MANUAL IS REQUIRED BY YOUR DEPARTMENT.
ACS (American Chemical Society) Style Guide: A Manual for Authors and Editors

AIP (American Institute of Physics) Style Manual

Associated Press Stylebook and Libel Manual

Chicago Manual of Style

Form and Style: Theses, Reports, Term Papers (William G. Campbell)
A Manual for Authors of Mathematical Papers (American Mathematical Association)
A Manual for Writers of Term Papers, Theses, Dissertations (Kate Turabian)
MLA (Modern Languages of America) Handbook for Writers of Research Papers
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Style Manual (United States Government Printing Office)
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A Uniform System of Citation (Harvard Law Review)
Instructions for Manually Inserting a Landscape Page Number

Directions: Follow steps 1-15 to add a landscape page with a properly positioned page number. Screen shots have been added for your convenience.

Step 1
Place your cursor at the point in your document where you wish to insert a landscape page. Turn on Show Paragraph Marks by navigating to the Home tab and clicking on the Paragraph symbol (¶) or press Ctrl+Shift+8. Navigate to the Page Layout tab and click on the Breaks drop-down menu in the Page Setup section. Select Next Page and insert two Next Page section breaks.
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Step 2
While you are still in the Page Layout ribbon, change the orientation of the second page (i.e., the one with the second Section Break) from portrait to landscape by clicking on the Orientation button.
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Step 3
Now, double-click in the top margin of the landscape page until the Header appears. A new tab will now open in your ribbon, the Header and Footer Tools (Design). Turn off the Link to Previous on the landscape page as well as the following page. Notice that the headers are now called Header Section 1, Header Section 2, and Header Section 3. The landscape page should be Section 2.
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Step 4
The next step is to create a text box in the Header of the landscape page. Delete any existing page number. Click on the Insert tab and then Text Box. A drop-down menu should appear. Select Simple Text Box.
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Hint: The text box should appear in your Word document as is does in the screen shot below.
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Step 5
Replace the default text within the text box with a page number by highlighting the text within the text box, then clicking on the Insert tab. Now, click on Page Number. A drop-down menu will appear. Select Current Position and then Plain Number.
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Step 6
Highlight the page number in the box and change both the default typeface and font of Calibri, 11 point to Times New Roman, 12 point by clicking on the Home tab and making these changes under the Font section. Next, open the Paragraph dialog box by clicking the arrow in the Paragraph section under the Home tab.
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Step 7
In the Paragraph dialog box under the Spacing section, change the point value of the Before box to 9 points and the point value of the After box to 0 points. Then, change the Line Spacing to Single by selecting this option from the drop-down menu. Finally, check the box that reads: Don’t add space between paragraphs of the same style.
Hint: The Paragraph dialog box should appear as follows. Select OK to move to the next step.
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Step 8
Under the Drawing Tools (Format) tab that appears whenever you click on the text box, change the position of the text box by clicking on Position and then More Layout Options.
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Step 9
The Layout dialog box should appear. Changes must be made in all three tabs (e.g., Position, Text Wrapping, and Size). Let’s begin with Position. Under the Horizontal section, click the Absolute Position bubble and change the point value to 9.23. Make sure to select Column from the drop-down menu across from this point value. Now, under the Vertical section, click the Absolute Position bubble and change the point value to 6.62. Make sure to select Paragraph from the drop-down menu across from this point value. Once you have completed these steps, click on the Text Wrapping tab.
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Step 10
Under the Distance from Text section, change all of the point values (i.e., Top, Bottom, Left, and Right) to 0. Then, click on the Size tab.
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Step 11
Under the Size tab, click on the Absolute bubble and change the point value to 1. Under Width, change the point value to .55. Once you have completed all of these step under the Position, Text Wrapping, and Size tabs, click the OK button.
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Step 12
Click on the Text Direction drop-down menu and select Rotate All Text 90 degrees.
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Step 13

Now, click on the Align Text drop-down menu and click Left.
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Step 15
The next-to-last step is to remove the lines of the text box. Click on Shape Outline and select No Outline from the drop-down menu.
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Step 16
Finally, double-click in the body of the page to get out of the Header.

Note:  This table was formatted and inserted as a text box that was rotated 90º counterclockwise.  To build the table, use either the “insert table” option within the text box or construct the table using tabs.  Maximum size for a table in landscape format is 6” tall by 9” wide.





Table 2.--Soil parameters (mean + 1sd) and results of ANOVA among DTSER sampling sites.  (Note:  This table represents proper formatting for a landscaped table and one that carries over to additional pages.)


	


		Site	


	1	2	3	4	5	6


	


Total Clay, % of total ***	44.4 + 1.0	33.2 + 0.3	62.2 + 12.2	74.3 + 2.3	16.4 + 17.9	44.2 + 3.9


	Carbonate Clay	0.2 + 0.2	1.0 + 0.3	0.7 + 0.5	0.1 + 0.1	2.3 + 2.3	2.1 + 1.5


Total Silt, % of total *	16.0 + 0.5	7.3 + 0.6	12.5 + 6.9	8.2 + 2.6	3.5 + 2.7	7.1 + 3.0


	Fine Silt	7.6 + 0.2	3.7 + 0.7	6.2 + 3.7	4.4 + 2.0	2.1 + 1.8	3.9 + 1.8


	Coarse Silt **	8.3 + 0.3	3.6 + 0.3	6.3 + 3.6	3.8 + 0.8	1.4 + 1.0	3.2 + 1.3


Total Sand, % of total ***	32.2 + 0.5	42.6 + 0.7	5.7 + 16.2	57.1 + 1.0	75.4 + 20.7	42.1 + 6.3


	Very Fine Sand ***	11.4 + 0.3	2.4 + 0.6	0.9 + 0.7	1.2 + 0.6	7.1 + 4.2	14.5 + 2.2


	Fine Sand *	7.3 + 0.2	6.8 + 1.2	2.9 + 2.3	2.8 + 0.3	16.7 + 9.9	9.9 + 1.7


	Medium Sand **	6.5 + 0.3	17.9 + 2.3	5.6 + 5.9	1.4 + 0.3	8.5 + 5.4	8.7 + 1.9


	Coarse Sand *	5.7 + 0.1	11.6 + 2.0	4.7 + 5.8	1.1 + 0.6	23.0 + 15.1	7.0 + 1.4


	Very Coarse Sand *	1.3 + 0.3	3.9 + 0.7	1.6 + 2.0	0.6 + 0.2	20.1 + 16.8	2.0 + 0.4


Coarse Fragments, % of total ***	3.2 + 1.3	12.5 + 1.7	4.2 + 2.9	5.6 + 0.1	2.3 + 1.1	2.8 + 0.9


	2-5mm wt % <75mm *	61.8 + 0.4	77.5 + 0.7	82.9 + 4.6	88.8 + 2.9	47.7 + 34.1	67.1 + 2.6


	5-20mm wt% <75mm	10.6 + 0.2	8.6 + 1.6	7.6 + 3.6	5.2 + 2.3	7.4 + 6.8	5.9 + 2.6


	20-75mm wt% <75mm	27.5 + 0.4	14.0 + 1.2	9.4 + 2.0	6.0 + 0.5	44.8 + 36.0	27.1 + 3.6


Walkley-Black Organic Fraction **	2.5 + 0.1	2.5 + 0.6	3.1 + 0.1	2.8 + 0.4	1.4 + 0.2	2.2 + 0.5


	





Table 2. (cont.)  (Note: The table number and all column headings must be carried over to all additional pages of a multi-page table.)


	


		Site	


	1	2	3	4	5	6


	


Organic Matter **	4.3 + 0.1	4.3 + 0.9	5.3 + 0.2	4.8 + 0.7	2.4 + 0.3	3.8 + 0.9


15 bar water on air dry soil, wt % **	17.0 + 0.9	14.7 + 1.0	14.1 + 3.4	11.1 + 1.4	19.0 + 1.2	15.1 + 0.4


pH, 1:2 CaCl2 susp. ***	7.6 + 0.0	7.4 + 0.0	7.6 + 0.0	7.6 + 0.1	7.5 + 0.0	7.6 + 0.0


pH, 1:1 water susp.	7.6 + 0.0	7.6 + 0.0	7.6 + 0.1	7.6 + 0.0	7.6 + 0.0	7.7 + 0.1


	


*  p < 0.05; **  p < 0.01; ***  p < 0.001
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